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Many resources are available to help you get started using Scaffold. The Proteome Software website 
offers video tutorials, white papers and FAQ’s on various topics at http://proteome-
software.wikispaces.com/Resource+Library.  The Scaffold User’s Guide is found under the Help menu, 
and there is an online Help system built into the program which provides answers to many of your 
questions. You can find quick answers to many questions by clicking on the help  icons scattered 
throughout the program. This tutorial is intended to supplement these resources. It does not give a 
complete introduction to Scaffold. Rather, it will focus on some of the features that we have found to 
cause the most confusion in new users.  

The modules are designed to be independent, so you may choose to work on the units of 
greatest interest to you. 

For these exercises, we will use the demo files available through Scaffold’s Help menu under 
Open Demo Files. 
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Module 3. Quantitation and Statistics 

Exercise 1. Spectral Counting  
Open demo file Label-free.sf3. For convenience, hide the GO terms by selecting 

unchecking “Show GO Annotations” in the View menu. Set the thresholds to 99%, 
2, 95%. 

First, it is important to understand the meaning of the various display options for spectral 
counting. Scaffold 4 uses different terminology for these options than did previous versions. 
Now that peptides may be shared among different proteins, there are more options, and it is 
important to be very clear about the meanings of the terms.  

Display Options for Spectral Counting 

Unique peptides – peptides with different amino acid sequences, regardless of any modifications 

Unique spectra – spectra that differ in amino acid sequence, charge state or modifications 

Exclusive – associated with a single protein group 

Total – associated with a protein group, whether or not it is shared with other protein groups 

Scaffold 4 Name Scaffold 3 Name Description 
Exclusive Unique Peptide Count Number of Unique Peptides Number of different amino acid 

sequences that are associated 
only with this protein 

Total Unique Peptide Count  Number of different amino acid 
sequences that are associated 
with this protein  

Exclusive Unique Spectrum Count Number of Unique Spectra Number of distinct spectra 
associated only with this protein 

Total Unique Spectrum Count  Number of distinct spectra 
associated with this protein 

Exclusive Spectrum Count Number of Assigned Spectra Number of spectra associated 
only with this protein 

Total Spectrum Count Unweighted Spectrum Count Total number of spectra 
associated with this protein 
including those shared with 
other proteins 

Quantitative Value (Spectrum 
Counting) 

Quantitative Value Normalized value based on 
Inclusive Spectrum Count 
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Select protein 1.16 HBA_ORNAN and go to the Proteins View. 

Using the definitions above, and the Spectrum Table at the upper right, calculate the 
following values: 

Exclusive Unique Peptide Count       ___________ 

Total Unique Peptide Count              ___________ 

Exclusive Unique Spectrum Count   ___________ 

Total Unique Spectrum Count          ___________ 

Exclusive Spectrum Count                  ___________ 

Total Spectrum Count                         ___________ 

 

Confirm your answers by going to the Samples View and changing the Display Options 
setting.  
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Exercise 1 Result: 

Exclusive Unique Peptide Count       __1__     

Total Unique Peptide Count              __ 3__ 

Exclusive Unique Spectrum Count   __ 2__ 

Total Unique Spectrum Count          ___5__ 

Exclusive Spectrum Count                  __  4__ 

Total Spectrum Count                         __ 11__ 

 

Explanation: 

 

Only the first four spectra are exclusive to this protein (weight 1, and no Other Proteins).  These 
all have the same amino acid sequence, so they constitute one exclusive unique peptide, but 
there are two charge states, so they give two exclusive unique spectra and four exclusive 
spectra in all. 

Disregarding exclusivity, there are three different amino acid sequences, hence total unique 
peptide count is 3. Two of the peptides have both charge 2 and charge 3, so we have five for 
total unique spectra. The total spectrum count is just the number of spectra shown in the table, 
which is eleven. 
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Exercise 2: Quantitative Values 
The last Display Option in the dropdown is Quantitative Value. By default, this is set to 
Normalized Total Spectra, but this can be changed. The options are: 

Total Spectra 
Weighted Spectra 
Average TIC 
Total TIC 
Top 3 TIC 
Average Precursor Intensity 
Total Precursor Intensity 
Top 3 Precursor Intensity 
emPAI 
NSAF 

 
The Precursor Intensity options are only available if the intensities were calculated by the 
search engine and reported in the files loaded into Scaffold. Currently, precursor intensity 
quantitation is available from: 

Agilent Spectrum Mill 
Thermo Proteome Discoverer 
MaxQuant 
Mascot Distiller. 

 
To select the Quantitative Value type you would like Scaffold to display, open the Quantitative 
Analysis Setup either by clicking on the   icon or by choosing Experiment>Quantitative 
Analysis Setup. The settings are at the lower left. 
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Select “Total TIC” from the dropdown in the Quantitative Analysis Setup. 

Uncheck “Use Normalization” and go to the Samples View. Select Quantitative 
Value from the Display Options dropdown. 

 
Notice that the name of the value is shown in parentheses in the Display Options box. Also look 
at the values in the columns for BioSample1 and BioSample2.  
 
Return to Quantitative Analysis Setup, and check “Use Normalization”. The word Normalized is 
added to the Display Options box, and the values have been adjusted. 
 
Now go back to the Setup once more, and fill in a Minimum Value. Since we are looking at Total 
TIC, we need to enter a large number, so select “Other” from the dropdown. Type “2.5E7” into 
the box and click “OK”. 
 
Notice that any values that were previously below 2.50E7 have now been replaced by this 
minimum value and they are shown in parentheses. Parentheses indicate that the displayed 
value has been adjusted by filling in the minimum value for a smaller or missing value. 
 

The minimum value is designed to allow you to set a floor when calculating quantitative values 
to avoid identifying changes as significant when they may really only be a result of noise. 

 

Experiment with other choices and settings. 
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Exercise 2 Result: 
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Exercise 3: Fold Change 
Open demo file tutorial_6. Set filters to 99%, 2, 95%. Hide GO terms by 

unchecking “Show GO Annotations” in the View menu.  Open the Quantitative 

Analysis Setup .  
 
a) Fold Change by Sample 
Remove Samples Int-2 and Un-2 from the Selected Samples list. Now that there are only two 
samples, the Fold Change by Sample option should be available for selection. Click the radio 
button and click Apply. 
 
In the Samples View, you should see a new column called Fold Change by Sample. The two 
samples being compared are highlighted in color, with the purple as the numerator and peach 
as the denominator. If there are multiple MS Samples in a BioSample, the values are summed 
and the comparison is done at the BioSample level. 
 

 
 
Fold changes that are more than twofold, i.e. the ratio is >2 or < 0.5 are colored in green. INF 
indicates that the denominator was missing. These can be eliminated by setting a minimum 
value through Quantitative Analysis Setup. 
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b) Fold Change by Category 
Return to the Quantitative Analysis Setup. Add samples Int-2 and Un-2 to the Selected 
Samples list. Select Fold Change by Category, and set a Minimum Value of 0.5. Click Apply. 
 

 
 
Now the ratio is calculated at the category level. Note, however, that for the category 
comparison, Scaffold takes the AVERAGE of the values of all MS Samples in the category, and 
compares the averages. The reason is that categories may have different numbers of samples 
within them, and this should not affect the ratio. 
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Exercise 4: Statistical Testing 
 
Scaffold provides a variety of statistical tests designed to assess the significance of any 
observed differences in expression. Different tests are available depending on the number of 
samples in your dataset and how they are organized.  
 
T-Test compares two categories of samples and tells whether there is a significant difference in 
the protein levels between them. It is only available if your Selected Samples list contains 
exactly two categories, and each of them contains at least two BioSamples, because it is not 
reliable for smaller datasets. 
 
Fisher’s Exact Test is like a T-Test but is accurate for small numbers of samples. As a result, 
Scaffold lets you do a Fisher’s Exact Test if you have exactly two categories in your Selected 
Samples List, even if you only have one BioSample in each. 
 
ANOVA requires three or more categories, with at least two BioSamples in each. It tells 
whether there is significant variation among the categories, but does not tell you which of the 
samples is different. To see the differences, you can check the Quantitative Value Bar Chart in 
the Quantify View. 
  
Coefficient of Variance (or Variation) is useful if you have three or more BioSamples, but do not 
have replicates within them. You would like to have some idea which proteins exhibit 
meaningful differences in expression among the samples, but you cannot do a formal test of 
statistical significance. A large CV suggests that at least one of the samples is showing 
differential expression as compared to another. 
 

Open Demo file tutorial_6. Set thresholds to 99%, 2, 95%. Open the 
Quantitative Analysis Setup . 

 
This file contains four BioSamples, organized into two categories. Each BioSample consists of 
two MS Samples. 

a) Apply the T-Test with Normalization. 
Which protein demonstrates significantly different levels in the two categories? 

 
b) Go to Load Data, select the  Un-2 tab, right click and edit the BioSample. Change the 

Category name to “New”. Open the Quantitative Analysis Setup. Now that there are 
three samples, the T-Test and Fisher’s Exact Test are unavailable, but the ANOVA is 
allowed. Apply Anova with Normalization. 
1) Which protein shows significant variation among the categories? 
2) Which category is most responsible for this variation?  
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Exercise 2 Result: 
a)gi|1346343(+1) 

 
                  
b) 1)gi|1168320(+106) shows significant variation 

 

 
 

2)Un-2 is significantly lower for this protein 
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Release Information 

This document is applicable for Scaffold, Release 4.0 or greater, and is current until replaced. 

 
Copyright  © 2013. Proteome Software, Inc., All rights reserved. 

The information contained herein is proprietary and confidential and is the exclusive property of 
Proteome Software, Inc.. It may not be copied, disclosed, used, distributed, modified, or reproduced, in 
whole or in part, without the express written permission of Proteome Software, Inc. 

 
Limit of Liability Proteome Software, Inc.. has used their best effort in preparing this guide. 
Proteome Software, Inc. makes no representations or warranties with respect to the accuracy or 
completeness of the contents of this guide and specifically disclaims any implied warranties of 
merchantability or fitness for a particular purpose. Information in this document is subject to change 
without notice and does not represent a commitment on the part of Proteome Software, Inc. or any of its 
affiliates. The accuracy and completeness of the information contained herein and the opinions stated 
herein are not guaranteed or warranted to produce any particular results, and the advice and strategies 
contained herein may not be suitable for every user.  

The software described herein is furnished under a license agreement or a non-disclosure agreement. The 
software may be copied or used only in accordance with the terms of the agreement. It is against the law 
to copy the software on any medium except as specifically allowed in the license or the non-disclosure 
agreement. 

 
Trademark -  The name Proteome Software, the Proteome Software logo, Scaffold, Scaffold Q+, 
Scaffold Q+S, and the Scaffold, Scaffold Q+, and Scaffold Q+S logos are trademarks or registered 
trademarks of Proteome Software, Inc. All other products and company names mentioned herein may be 
trademarks or registered trademarks of their respective owners. 

 
Customer Support - Customer support is available to organizations that purchase Scaffold, 
Scaffold Q+ or Scaffold Q+S and that have an annual support agreement. 
 

Contact Proteome Software at: 
Proteome Software, Inc. 
1340 SW Bertha Blvd, Suite 10 
Portland, OR 97219 
1-800-944-6027 (Toll Free) 
1-503-245-4910 (Fax) 
www.proteomesoftware.com 
 

Document Version Number Scaffold 4.0-Tutorial-001 
Document Release Date June 5, 2013 
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